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1 Introduction

EagleFiler makes managing your information easy. It lets you archive and search mail, Web pages,
PDF files, word processing documents, images, and more. Use it to collect information from a
variety of sources. Browse different types of files using a standard three-pane interface. Organize
them into folders and annotate them with tags and notes, or leave everything in one folder and
pin-point the information you need using the live search. Since EagleFiler stores its library in
Finder format, you can use it in concert with the other tools in your Mac ecosystem.

1.1 Importing Is a Snap

Getting your information into EagleFiler is easy. When you’re viewing a Web page in Safari or
NetNewsWire1, looking at a mailbox in Mail, or browsing files in the Finder, just press the capture
key (F1 by default). EagleFiler will save the document into its library, and you can go right on
working without interrupting your flow. (Of course, you can also use drag and drop or other
methods if you prefer.) Once the document is in EagleFiler, you’ll always have a copy of the way it
looked when you imported it. No more bookmarking a great article, only to find out later that the
page is no longer available or that registration or even payment is now required. If you do research
on the Web, you know that pages change—sometimes without notice—so it’s always good to keep
a paper trail of exactly what you read. There’s no shame in being a digital pack rat when today’s
Macs ship with tens or even hundreds of gigabytes of storage.

1.2 Familiar Mail-like Interface

EagleFiler browser windows use a three-pane view that’s familiar to any Mail user. This is not a
database front-end; it’s a real Mac application with a fully Aqua user interface. Click on one or
more sources to view their contents. Enter some text in the search box to filter the record list.
Click on a record to view it right there in the window. HTML mail messages can be viewed as rich
text, or you can view e-mails as plain text, complete with color-coded quoted text and clickable
links. You can open as many windows as you want to view different parts of the library.

1.3 Search Everything

It’s no good to store your information if you can’t find it when you need it. Fortunately, EagleFiler
offers some powerful search options. If you know the title, author, or recipient you’re looking for,
you can search by one of those fields. Or, use EagleFiler’s indexed search to look through the
entire contents of your documents. Like Spotlight, EagleFiler can search different types of files at
once—after all, what matters is what you’re looking for, not whether it’s in a PDF, an e-mail, or
a chat. Unlike Spotlight, EagleFiler makes it easy to narrow down the results. You’re searching

1http://ranchero.com/netnewswire/
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within the library, not all the files on your hard disk, so the search is fast. You can select one or
more folders or mailboxes within the library to restrict the search—reducing the amount of data
that EagleFiler has to look through, and number of results that you’ll have to comb through. You
can even do Boolean, tag, and phrase-based searches to tell EagleFiler exactly what you’re looking
for. Once you’ve narrowed the search results to a manageable number of documents, it’s easy to
find the information you’re looking for because you can view the document contents right there in
EagleFiler.

1.4 The Library Is Open

Like iTunes and iPhoto, EagleFiler keeps your data in a library. The library is just a special folder
in the Finder that EagleFiler manages. You shouldn’t re-arrange the files and folders in the library
except through EagleFiler, but other than that you can treat it just like a regular folder. Browse
its contents in the Finder or Path Finder2—the folder structure matches the folders in EagleFiler.
View and edit the files using your favorite applications. Drag key files to the Dock or make aliases
of them on your desktop. Search the files using Spotlight. Label files in EagleFiler, and the labels
automatically show up in the Finder—and vice-versa. Files in the library will still show up in your
applications’s Open Recent menus, and Preview will still remember which page of the PDF you
were reading. In short, you can capture, organize, and search your files using EagleFiler, without
giving up the normal conveniences of the Mac experience.

1.5 Reliable Data Storage

The library may look like just a folder full of files, but EagleFiler uses a Core Data3 SQL database
to keep track of the files and their contents. This lets you put thousands of files in the library and
access them reliably and quickly. Each time you open a library, EagleFiler checks to make sure
that all the files are present. It can even verify the library (using MD5 checksums4) to make sure
that none of the files has been corrupted. There’s no point in storing and backing up damaged
files. When you archive your documents in EagleFiler, you can be sure that when you need to read
them again they’ll be in pristine condition. Plus, EagleFiler libraries go great with backups and
archival. Your data is stored in individual files, so smart backup and synchronization programs
won’t waste time and space copying the documents that haven’t changed. Since the files are in
standard formats like PDF, RTF, and mbox, you’ll be able to read them years from now, even
if—alas—you’re no longer using EagleFiler.

2http://www.cocoatech.com
3http://developer.apple.com/macosx/coredata.html
4http://en.wikipedia.org/wiki/Md5#Applications
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1.6 Add Tags and Notes

Tags are somewhat like labels in the Finder, except that each record can have as many tags as
you want. EagleFiler has some tags such as “unread,” “flagged,” and “replied” built-in, and it will
import these from Mail. If you’ve created additional tags in Mail using MailTags5, EagleFiler will
import those as well. You can also create your own tags. Tags may be treated like keywords, and
each tag also appears as a source in the browser window, which acts like a playlist in iTunes or an
album in iPhoto.

Each document or message in EagleFiler can also have a note. Notes are like comments in the
Finder on steroids. They support rich text with multiple fonts, sizes, and colors. Notes can even
include clickable links, graphics, tables, and lists. Use notes to write down information that goes
with your documents, to excerpt key passages, to add your own comments or analysis, or to add
links to related records in EagleFiler.

1.7 Speed Up and Simplify Your Other Applications

Most e-mail programs are designed for communicating with your mail server and letting you read
and write messages—not for storing all your old mail. By cleaning out your mail program’s
database, you can remove some clutter from its mailbox list and speed it up. But cleaning it
out doesn’t have to mean lots of time wasted trying to predict which messages you might need in
the future. Disk space is plentiful—just archive all your old mail into EagleFiler. Later, you’ll be
able to find what you need with a quick search. Meanwhile, the archived messages will no longer
be slowing down Spotlight searches of your files and current messages.

Likewise, your Web browser’s bookmarks feature is great for remembering sites that you’ll want
to go back to frequently. But it isn’t ideal for remembering the information found on Web pages.
Don’t bookmark news articles, recipes, reviews, and other documents—and then try to look through
your overflowing bookmarks folder to recall the articles by title and URL. Instead, capture the Web
pages into EagleFiler where you’ll be able to search their entire contents.

1.8 Multiple Libraries

Some people like to dump all their information into a single EagleFiler library, with minimal folder
structure, and locate documents that they need using the search feature. But EagleFiler also
supports multiple libraries, for those who like to separate their business and personal files, group
them by project or client, or keep different kinds of files in different places. For example, you might
keep some of your files on your iPod or keychain drive, some on an encrypted disk image6, and others
in your Documents folder. However you want to group your files, EagleFiler can accommodate.

5http://www.indev.ca/MailTags.html
6http://c-command.com/dropdmg/manual-ah/protecting-your-files-w
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2 Installing and Updating

2.1 Requirements

Mac OS X 10.4 or later is required. EagleFiler is a universal binary that runs natively on both
PowerPC- and Intel-based Macs.

It is also recommended that you install Growl7 so that you get a notification each time a document
is imported into EagleFiler.

2.2 Updating From a Previous Version

The easiest way to update EagleFiler is to use the Software Update command to download and
install the latest version.

Alternatively, you can replace the old EagleFiler application file with the new one. That is, if
EagleFiler is installed in the Applications folder, drag the new EagleFiler application icon into
the Applications folder and click Replace when the Finder asks if you want to overwrite the old
version. If you get an error saying that you do not have sufficient privileges, drag the old EagleFiler
to the trash and empty it, and then drag the new one into the Applications folder.

2.3 Installing EagleFiler

Double-click the EagleFiler-1.1.dmg file to mount the EagleFiler disk image. Then drag the
EagleFiler application to your Applications folder.

2.4 Uninstalling EagleFiler

To uninstall EagleFiler, drag its application file to the trash. Although you will no longer be able
to open your libraries with EagleFiler, the files in the libraries will remain accessible in the Finder.
Next to each library is a folder called Files (which contains the files and folders in the library)
and a folder called Notes (which contains any notes that you’ve added).

7http://growl.info
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3 Importing

3.1 What Can Be Imported

The following types of information can be imported into EagleFiler:

• Bookmarks from Safari8 and OmniWeb9, which will be downloaded and converted to Web
archives.

• Chat transcripts. iChat10 logs chats as .chat or .ichat files in the folder:

/Users/<username>/Documents/iChats

Adium11 logs chats as HTML files in the folder:

/Users/<username>/Library/Application Support/Adium 2.0/Users/Default/Logs

• Folders. EagleFiler imports the contents of the folder (and any subfolders, preserving the
hierarchy).

• HTML files.

• Images.

• Mailboxes in mbox format and Apple Mail mailboxes, attachments included. After importing
messages into EagleFiler, you may wish to delete them from you mail client and merge them
into a previously imported mailbox with the same name.

Apple Mail
Mailboxes can be dragged directly from Mail’s mailbox list into EagleFiler. Or, select
the mailboxes and press the capture key. EagleFiler will preserve the message status
and flagged indicators from Mail, as well as any keywords, projects, and notes from
MailTags12. The mail will be converted to standard mbox format. EagleFiler is able
to import messages from IMAP mailboxes, however it will only import the parts of the
messages that have been downloaded from the server. Thus, it is recommended that you
select the option in Mail’s preferences to keep All messages and their attachments
for offline viewing.

Entourage
Drag mailboxes directly from the mailbox list to EagleFiler. You can also drag individual
messages or exported .eml files.

8http://www.apple.com/macosx/features/safari/
9http://www.omnigroup.com/applications/omniweb/

10http://www.apple.com/macosx/features/ichat/
11http://www.adiumx.com
12http://www.indev.ca/MailTags.html
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Eudora
Mailboxes are stored in the Mail Folder folder inside the Eudora Folder folder, and
they can be dragged from the Finder into EagleFiler. They are not actually in mbox
format (for example, the attachments are removed), but the format is close enough that
EagleFiler will be able to read most of the messages.

GyazMail
Select some mailboxes and choose File . Export . Unix mbox. . .. Then drag the
exported files into EagleFiler.

Mailsmith
Use the capture key to import the selected mailboxes or drag the selected messages
into EagleFiler. In Mailsmith 2.1.5, dragging mailboxes directly to EagleFiler will not
work, but you can drag mailboxes to the Finder and then drag the exported files into
EagleFiler.

PowerMail
Select some mailboxes and drag them to the Finder. Choose Unix Mailbox when it
asks you to pick a format. Then drag the exported files into EagleFiler.

Thunderbird
The mailboxes are stored in the folder:

/Users/<username>/Library/Thunderbird/Profiles/<profile>/Mail/Local Folders/

and can be dragged from the Finder to EagleFiler.

• Microsoft Word files.

• Movies.

• PDF files.

• PostScript and EPS files.

• Rich Text (RTF and RTFD) files.

• Sounds and music.

• Text files (encoded with ASCII or UTF-8, or with a byte-order-mark) and text clippings.

• URLs, which will be downloaded and converted to Web archives.

• Web archives.

• Other files. Documents that aren’t of any of the above types can also be imported into
EagleFiler, however to view their contents you will need to use the Open in External Viewer
command.
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3.2 Ways to Import

There are many ways to get your files into EagleFiler. You can:

• Press the capture key.

• Drag files, text, or a URL onto:

– A EagleFiler browser window’s source list or records list.

– The Drop Pad.

– The EagleFiler application icon.

• Control-click on a file in the Finder and choose Open With . EagleFiler.

• While viewing a document in another application, choose File . Print and then choose Save
PDF to EagleFiler from the PDF button menu. This will convert the document to PDF
format and import it into EagleFiler.

• Choose Import File(s). . . from the File menu.

• Choose Import URL(s). . . from the File menu.

• Select some items or text in another application and choose Import File, Import Text
(Command-<), or Import URL from the EagleFiler section of the Services menu (inside
application menu). You may have to log out and log in again after installing EagleFiler in
order for it to appear in the Services menu. You can assign the keyboard shortcuts for the
services in the Keyboard pane in System Preferences or using Service Manager13 or Service
Scrubber14.

• Run an AppleScript such as:

tell application "EagleFiler"
tell library document 1

import files {POSIX file "/Users/mjt/Desktop/Foo"}
import URLs {"http://www.apple.com", "http://c-command.com"}

end tell
end tell

In all cases, the data is copied into the EagleFiler library (as with iPhoto). EagleFiler automatically
detects duplicate files so that only one copy of each document is stored in the library.

If more than one library is open (and you didn’t drag into a specific browser window), EagleFiler
assumes that you meant to import into the current library (the one with the frontmost window).
If no library is open, EagleFiler will show a dialog asking you to open one; then you can click the
Import button to import the files into that library.

13http://www.blacktree.com/apps/servicemanager/index.html
14http://www.petermaurer.de/nasi.php?section=servicescrubber
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3.3 Don’t Make Changes While Importing

EagleFiler will show a red circle (like a VCR’s Record button) in its Dock icon, while it is importing
files.

It can take a few seconds (or minutes, for large mailboxes) to import a file into EagleFiler. You
should not make any changes to the files being imported during this time. Doing so could cause
EagleFiler to copy the file in an inconsistent state. This also applies to mailboxes. For example,
do not move messages into or out of an Apple Mail mailbox while that mailbox is being imported.

3.4 Writing Capture Scripts

You can add support for capturing from additional applications by adding capture scripts to the
folder:

/Users/<username>/Library/Application Support/EagleFiler/Capture Scripts/

A capture script is an AppleScript saved in compiled format. The name of the file is of the form
<bundle identifier>.scpt, e.g. com.apple.Safari.scpt. You can determine an application’s
bundle identifier by finding the CFBundleIdentifier in the Info.plist file inside the application’s
package (which you can open using the Show Package Contents command when Control-clicking
on the application).

The script should have a handler called capture that returns a list of AppleScript records. For
example, the NetNewsWire capture script looks like:

on capture()
tell application "NetNewsWire"

set tabIndex to index of selected tab
if tabIndex is 0 then

if exists selectedHeadline then
set theURL to URL of selectedHeadline

else
return {{|error|:"No URL is available to be captured."}}

end if
else

set theURLs to URLs of tabs
set theURL to item (tabIndex + 1) of theURLs

end if
end tell
return {{|url|:theURL}}

end capture
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Each record in the list should have a |url| key (for a remote http URL) or a |path| key (for a
full POSIX path). If no items are available for capture, the script can return the empty list, or it
can return a record with a |error| key that provides an application-specific error message.

The capture script for the Finder demonstrates how to capture multiple items at once:

on capture()
tell application "Finder"

set theSelection to selection as list
set theResult to {}
repeat with theFile in theSelection

set theFile to theFile as alias
copy {|path|:POSIX path of theFile} to end of theResult

end repeat
return theResult

end tell
end capture

If the script creates a temporary file for the capture, it can include a |deleteWhenDone| key with
value true so that EagleFiler will delete the temporary file after it has finished importing the file.

Additionally, the |tags| key (which maps to a list of strings) and the |note| key (which maps to
a string) may be used to specify tag names and note text.

4 Browser Windows

Each browser window contains a source list, a records list, a record viewer, and a toolbar. Drag
the split bars to resize the different portions of the window. Double-click a split bar to collapse it
entirely. Hold down the Option key while dragging a split bar to grow or shrink the window as you
drag.

You can use the Tab key to move between the different panes using the keyboard. When editing
in the record viewer, you may need to type Control-Tab rather than Tab (which will insert a tab
character into the document).

4.1 Source List

Drag files here to import them. You can drop onto a folder or tag source to import files directly
into that folder or to import them and assign that tag. You can use Exposé mid-drag to bring a
window to the front and reveal the source that you want to drop onto.

The top-level sources are:
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Library

All the records in the library, organized the same way as the library’s Files folder in the
Finder. Each file is stored in exactly one folder in the library, and you can drag and drop to
re-arrange files and folders.

Recently Added

The last 25 records that were added to the library.

Recently Modified

The last 25 records that were modified.

Tags

Tag sources behave like playlists in iTunes or albums in iPhoto. Select a tag source to view
all the records with that tag. You can drag records onto a tag source to assign that tag to
them. Each record may appear in any number of tag sources. Deleting a record from a tag
source unassigns that tag; the record remains in the library.

Unfiled

Files that are at the top level of the library, e.g. ones that are not in a named folder.

Trash

The records that have been deleted from the library, but which are still available until you
empty the trash. This corresponds to the library’s Trash folder in the Finder.

You can select more than one source at a time to view all their contents at once. You can type the
first few letters of a source’s name to select it.

4.2 Records List

The records list shows the contents of the selected source(s). If a folder or tag is the selected source,
you can drag files into the records list to import them with that folder or tag. The columns are:

Tags

The abbreviations for the assigned tags.

Count

The number of pages in a PDF, messages in a mailbox, or attachments in a message.

Icon

An icon that shows the record’s type.

Title

The subject of a message or title of a document.
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From

The sender of a message or author of a document.

To

The recipient of a message or document.

Date

The date the record was modified.

Date Added

The date the record was added to the library.

Size

The amount of disk space used by the record.

File

The name of the file containing the record.

Kind

The type of the record.

Label

The Finder label of the record’s file.

Container

The name of the folder or mailbox that the record is inside.

You can type the first few letters of a record’s title to select it. Click the 5 to choose which columns
are visible. Double-clicking a record in the list is equivalent to choosing Open in External Viewer.
Option-double-clicking is equivalent to choosing Open Source URL.

4.3 Record Viewer

The record viewer shows the contents of the selected record. Text, RTF, and RTFD records can be
edited directly in the viewer. There is also a bar at the bottom of the viewer for editing the tags
of the current item.

4.4 Searching

The search box lets you filter the records of the selected sources to display only those records that
match the search criteria. Five different locations may be searched:
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Anywhere

Searches the contents of the records, as well as the Title, From, To, Cc, attachment names,
and notes. This is an indexed word search that uses the following syntax:

"

Opening and closing delimiter for phrase-based searching. Unlike with Google, phrase-
based searches match words that appear next to each other, but not necessarily in the
order specified.

(, )
Opening and closing delimiters for logical grouping.

!, NOT
Boolean NOT.

&, AND
Boolean AND. The <space> character also represents a Boolean AND.

|

Boolean inclusive OR.

*

Wildcard for prefix or suffix. Ignored in phrase-based searches. To search for a partial
word, use two *’s, e.g. *ant* will find ant, repellant, anthem, and words with ant in
the middle.

tag:<tagname>

At the beginning of the query, you can include one or more tag specifiers. The search
will then match only the records with all of those tags. For example, searching for
tag:apple steve means to search for steve and show only the records with the apple
tag. Searching for tag:mac tag:ipod halo !bungie means to find all the records that
include the word halo, do not include the word bungie, and have both the mac and
ipod tags.

From

This is an exact search that examines both the names and addresses.

Tags

This is an exact search for the tag names that you enter.

To/Cc

This is an exact search that examines both the names and addresses.

Title

This is an exact search for record titles and message subjects.

Notes

This is an indexed word search (as with Anywhere) of the notes of the displayed records.
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5 Menus

5.1 The EagleFiler Menu

5.1.1 About EagleFiler

The About EagleFiler window shows the credits, as well as download and support information.

You can always download the latest version of EagleFiler from the EagleFiler Web site15.

Questions about EagleFiler may be sent to eaglefiler@c-command.com16. I’m always looking to
improve EagleFiler, so please feel free to send any feature requests to that address.

To make sure that you have the latest version of EagleFiler, you can use the Software Update
feature or subscribe to the EagleFiler News mailing list17. The traffic on this list is very low, only
one message per new version of EagleFiler.

The EagleFiler RSS feed18 contains update notices and other EagleFiler news.

The EagleFiler forum19 is the place to talk with other EagleFiler users, share tips and tricks, and
ask questions.

5.1.2 Software Update

Click the Check Now button, and EagleFiler will tell you whether a newer version is available for
download. By default, EagleFiler will automatically check for new versions each time it is launched
and once per day. You can disable this feature by unchecking the checkbox.

If a new version is available, EagleFiler will tell you what’s new in that version. Click Download
to have EagleFiler download the .dmg file for the new version to your Internet downloads folder.
Click Download & Install to have it download the .dmg and then update the installed EagleFiler
application to the new version.

To check for a new version, EagleFiler contacts a Web server at dreamhost.com. EagleFiler trans-
mits the following information to the server: the name of the product (EagleFiler) and its version,
the version of Mac OS X, whether EagleFiler is registered, and the name of the current language.
This information is used to guide future development. No personal information is transmitted.

15http://c-command.com/eaglefiler/
16mailto:eaglefiler@c-command.com
17http://c-command.com/eaglefiler/support
18http://c-command.com/blog/category/eaglefiler/feed
19http://c-command.com/forums/forumdisplay.php?f=7
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5.1.3 Purchase

This window lets you buy EagleFiler. If you’ve already purchased EagleFiler but it’s running in
demo mode, you can you enter your name and serial number to personalize your copy of EagleFiler
and remove the demo limitations.

EagleFiler has a free trial period that lasts for 30 days or 7 launches, whichever is longer. To use
EagleFiler beyond the demo period, you must purchase it. This entitles you to free updates and
support.

To purchase, choose Purchase. . . from the EagleFiler menu. You can use the Purchase button
to enter the online store.

Soon after paying, you’ll receive an e-mail with your serial number. Enter the name and serial
number from the e-mail into the Purchase window and click Personalize. If you need to re-
install EagleFiler, you can simply re-enter your name and serial number and click Personalize;
there’s no need to purchase again.

If you purchased EagleFiler but cannot find your serial number, click the Lost Your Serial
Number? button. This will open a form where you can enter your e-mail address and look up
your order information.

A license for EagleFiler is good for one person or one computer. You can install it on one Mac,
and everyone sharing that Mac can use it (on that Mac). Alternatively, you can install it on your
desktop Mac and your PowerBook; you can then use it on either machine, provided that no one is
using it on the other machine.

5.2 The File Menu

5.2.1 New Library. . .

Creates a new library. Each library is a folder containing a Files folder, a Notes folder, and a
.eflibrary file. Double-click the .eflibrary file to open the library in EagleFiler. You can move
the library folder around in the Finder (when it isn’t open in EagleFiler), but do not modify its
contents.

5.2.2 New Folder. . .

Creates a new folder in the source list of current library.
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5.2.3 New Rich Text File

Creates a new RTFD file inside the selected source. If the File column is visible, EagleFiler brings
it into edit mode so that you can set the name of the newly created file. Otherwise, EagleFiler
opens a sheet that lets you enter the title and contents for the new file. You can press Enter to
dismiss the sheet and use Control-Tab to jump back and forth between the text fields.

5.2.4 New Browser Window

Creates an additional browser window for viewing the contents of the current library.

5.2.5 New Tag

Creates a new tag and selects it in the source list. If records are selected, they are assigned the
new tag.

5.2.6 Open Library. . .

Opens a .eflibrary file.

5.2.7 Import URL(s). . .

Opens a sheet for importing one or more URLs into the current library as Web archives. The text
box will be pre-filled with the contents of the clipboard.

5.2.8 Import File(s). . .

Opens a dialog that lets you choose one or more files or folders to be imported into the current
library.

5.2.9 Export. . .

Opens a dialog that lets you choose a folder to which the selected records will be exported.
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5.2.10 Empty Trash. . .

Empties the trash of the current library.

5.3 The Edit Menu

5.3.1 Undo/Redo

Most actions in EagleFiler can be undone and redone, and EagleFiler supports multiple levels of
undo. When you close a library or empty the trash, EagleFiler clears the list of undoable actions
for that library.

5.3.2 Copy

Copies the selected text, the titles of the selected records or sources, or the names of the selected
tags.

5.3.3 Copy Record Link

Copies a x-eaglefiler URL to the clipboard for each selected record. Opening the URL will
launch EagleFiler, open the library, and select the record so that its contents are shown in the
viewer.

If you move the library folder in the Finder, previously copied x-eaglefiler URLs for that library
will no longer work.

Instead of copying and pasting, you can also drag a record into a text view to create a link to it.

5.3.4 Copy Source URL

Copies the original http URLs for the selected Web Archive records. For other kinds of records,
copies file URLs for the files in the library.
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5.4 The View Menu

5.4.1 Message . Raw Source

If this is checked, the viewer will show the raw RFC-82220 source for e-mail messages. If it’s
unchecked, the viewer will instead show the Subject, From, Date, To, and body of the message.

5.4.2 Message . Plain Text

If this is checked, EagleFiler will show all e-mail messages in plain text format. For HTML-only
messages, a plain text representation will be created. If this is unchecked, HTML messages will be
shown using rich text and plain text messages will be shown in plain text.

5.4.3 Show . Source List

Hides or shows the source list. As a shortcut, you can double-click on the divider.

5.4.4 Show . Record Viewer

Hides or shows the record viewer. As a shortcut, you can double-click on the divider.

5.4.5 Show . Messages in Tag Sources

If this is checked, EagleFiler will show e-mail messages (from all your mailboxes) as well as files
in tag sources. Uncheck it if you want to avoid the clutter of seeing all the e-mail messages, or if
viewing tag sources is slow because you have lots of messages. This setting is saved per-library.

5.4.6 Allow Editing in Record Viewer

This controls whether Text, RTF, and RTFD records can be edited directly in the record viewer,
without opening the file in another application. You might uncheck this if you want to avoid making
accidental changes while viewing a record.

20http://www.ietf.org/rfc/rfc0822.txt
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5.4.7 Previous/Next Record

These commands select the previous or next record in the record list. This lets you change which
record is being viewed while the viewer pane has keyboard focus.

When the records list or the record viewer has keyboard focus, you can type Spacebar or Shift-
Spacebar to select the next or previous record.

5.4.8 Select Source

If you have a folder or mailbox selected in the record list, this command reveals and selects it in
the source list. Otherwise, the container of the selected record is selected in the source list.

For example, if the Library source is selected, you can use the search box to enter the name of
the folder that you want to view, select it in the record list, and then choose Select Source. This
is often quicker than expanding the various folders inside the Library source to find the one you
want.

5.4.9 Open in New Window

This opens a new browser window in EagleFiler to view the selected records.

5.5 The Record Menu

5.5.1 Mark Unread/Read

Add (or remove) the “unread” tag to the selected records.

5.5.2 Flag/Unflag

Add (or remove) the “flagged” tag to the selected records.

5.5.3 Tag

Gives keyboard focus to the tags text field at the bottom of the browser window, which lets you
edit the tags of the selected record.
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5.5.4 Show Inspector

This window lets you view and edit the properties of the selected records. You can type Tab to
move between to text fields, or Control-Tab to move out of the notes text view.

File Properties

This shows the file’s name, kind, size, and dates, as well as EagleFiler metadata such as the
title, from, and to.

If a record doesn’t have a title and you haven’t set one manually, EagleFiler will use the
filename (without the extension) as the title, and the title will stay in sync with the filename
if you rename it.

Label

This is the Finder label of the file. In EagleFiler, the label is shown as the background color
in the records list and also in the Label column. E-mail messages are stored as mailboxes,
not as individual files, so all the messages in the mailbox share the mailbox file’s label. You
can edit the label names from the Finder’s Preferences window.

Tags

This shows the tags assigned to the record. You may find it more convenient to create and
assign tags by typing them in the text field than by using the Show Tags command.

Notes

Notes support rich text, clickable links, embedded graphics, tables, etc. Most of the commands
for editing notes are in the Format menu. As a shortcut, you can type Option-Tab to start
a bulleted list or Option-Shift-Tab to dedent the current list item.

5.5.5 Show Tags

This window shows a list of tags for the current library. The columns are:

√

The box is checked if all of the selected records in the browser window have this tag. It shows
a - sign if some (but not all) of the selected records have the tag. It is disabled if no records
are selected.

•
The abbreviation (if any) for the tag. Abbreviations are shown in the Tags column of
the records list; for example, the “unread” tag is shown as a blue •. Double-click on an
abbreviation to edit it. The abbreviation can be composed of ordinary letters, or of special
symbols that you access using the Characters button in the toolbar.
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Name

The name of the tag. Double-click on a name to edit it. (The names of built-in tags such as
“unread” cannot be edited.) Each tag must have a unique name.

You can give the tags palette keyboard focus by:

• Clicking in its title bar.

• Choosing Show Tags from the Record menu.

• Clicking the Tags button in the toolbar of a browser window.

• Editing an abbreviation or name.

Once the tags palette has keyboard focus, you can:

• Type the first few letters of a tag’s name to select it in the list.

• Press the spacebar to toggle whether the selected records in the browser window have the
selected tags. This is like checking or unchecking the boxes of all the selected tags at once.

• Click the Colors button in the toolbar. Then choose a new color for the selected tag(s) and
abbreviation(s).

5.5.6 Convert For Editing

Converts the selected Web archives to (editable) rich text files, preserving the tags, notes, source
URL, and other metadata.

5.5.7 Merge Mailboxes

This merges the selected mailboxes into a single mailbox file with the name and location of the
oldest mailbox in the selection. The tags and notes of the messages are preserved. The original
mailboxes are then moved to the trash.

Merging mailboxes can reduce clutter in the source list and speed up EagleFiler.

5.5.8 Reply to Message

This lets you reply to a message in your default e-mail program.
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5.5.9 Verify

This checks the selected records and their notes to make sure that the files are not damaged.

5.5.10 Open in External Viewer

This opens the selected records in a specialized viewer application such as Preview, Safari, or Mail.
Folders and mailboxes will open in a new window in EagleFiler.

If a search is in effect, EagleFiler passes the search string to the external viewer so that it can show
you the matches in the document.

Double-clicking a record is a shortcut for choosing this command from the menu.

Hold down the Option key to open the source URL instead of the stored file.

5.5.11 Open Source URL

With a Web archive record (or an RTFD file converted from a Web archive) selected, this opens
the (live, not archived) Web page in your Web browser.

5.5.12 Open in del.icio.us

This opens a Web archive’s URL in the del.icio.us21 social bookmarking site to help you find related
pages.

5.5.13 Reveal in Finder

This shows the selected records in the Finder. If you have Path Finder22 running, the files will be
revealed in it instead.

21http://del.icio.us
22http://www.cocoatech.com
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5.6 The Window Menu

5.6.1 Activity Viewer

EagleFiler can do many operations—such as adding files and URLs to the library, indexing,
verifying—in the background. This window shows a list of the tasks that EagleFiler is currently
working on for each library.

5.6.2 Drop Pad

You can drag files onto the Drop Pad to import them into the current library. The current library
is the library whose browser window is in the front. You can use the pop-up menu on the Drop Pad
to change the current library (without introducing window clutter). The Drop Pad also provides
information about whether EagleFiler can capture from the current application.

5.6.3 Errors

This window shows a list of errors that have occurred since you launched EagleFiler.

5.7 The Help Menu

This menu provides access to the full EagleFiler documentation (in Apple Help or PDF format) as
well as a link to the technical support Web site.

5.8 The Dock Menu

The Capture From <Application> command is equivalent to pressing the capture key. The
Import Clipboard command will import any text on the clipboard as a new rich text file. The
Open Recent commands let you access EagleFiler libraries that might not currently be open.

6 Preferences

6.1 Capture Key

You can always import into EagleFiler using Import URL(s). . ., Import File(s). . ., or drag and drop.
However, if you are already viewing the information that you want import in another application,
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it’s much easier to just press the capture key. When you press the capture key (F1 by default—
notebook users may also need to hold the fn key), EagleFiler automatically determines what you’re
currently viewing and imports it into the current library. EagleFiler will play a camera sound to
let you know that the capture has started. When it’s finished, if you have Growl23 installed, you’ll
see a notification bubble.

EagleFiler can capture from these applications:

BBEdit

Captures the file of the first document of the front window.

Camino

Captures the URL of the current tab.

Cocoalicious

Captures the URLs of the selected posts.

Endo

Captures the selected news items as Web archives, preserving their tags and importing the
excerpts as notes.

Finder

Captures the selected files in the front window.

Firefox

Captures the URL of the current tab.

iCab

Captures the URL of the front window.

Mail

Captures the selected mailboxes or messages in the front viewer window. Tags, projects, and
annotations from MailTags24 are preserved.

Mailsmith

Captures the selected mailboxes.

Microsoft Word

Captures the file of the front window.

Netflix Freak

Captures the URLs of the selected movies.
23http://growl.info
24http://www.indev.ca/MailTags.html
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NetNewsWire (but not NetNewsWire Lite)

Captures the URL of the current tab, or the URL of the selected headline (if no tab is
selected).

OmniWeb

Captures the URL of the current tab.

Path Finder

Captures the selected files in the front window.

Safari

Captures the URL of the current tab.

SubEthaEdit

Captures the file of the front window.

TextEdit

Captures the file of the front window.

TextWrangler

Captures the file of the first document of the front window.

Vienna

Captures the URL of the last selected post.

WebnoteHappy

Captures the selected URLs as Web archives, preserving the tags and notes.

If you’d rather import just the selected text instead of the entire Web page or document, you can
use EagleFiler’s Import Text service (Command-<) instead of the capture key.

In some cases, EagleFiler captures the information directly from the application’s internal storage.
Thus, you should not modify it while the capture is in progress. For example, do not check for new
mail or move messages between mailboxes while capturing from Mail. If you are capturing from
the Finder or Path Finder, do not modify the files during the capture.

EagleFiler must be running in order for the capture key to work. Thus, you may wish to add
EagleFiler to your Login Items in the Accounts pane of System Preferences.

6.2 Fonts

Sources

Used in the source list in browser windows.
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Lists

Used in the records list in browser windows and in the list of tags in the tags inspector.

Rich text

Used for e-mail header information, HTML messages, and as the default font for notes.

Plain text

Used for plain text e-mail messages.

The fonts for Web archives are mostly controlled by the Web archives themselves. The default font
families and sizes can be controlled using Safari’s preferences.

6.3 Quoted Text Colors

EagleFiler colors plain text e-mail messages according to the number of quote characters at the
start of each line. The pop-down menu lets you choose a preset coloring scheme.

6.4 Remember open libraries between launches

If this is checked, EagleFiler will remember which libraries were open when you quit it, and it will
re-open them the next time EagleFiler is launched.

In addition, you can put aliases to your favorite libraries in the folder:

/Users/<username>/Library/Application Support/EagleFiler/Startup Items

so that EagleFiler will always open them at launch. You can hold down the Shift key at launch to
prevent it from re-opening the libraries or opening the startup items.

7 Frequently Asked Questions

7.1 Why doesn’t my serial number work?

You need to enter the serial number name and serial number exactly as they appear on your order
confirmation e-mail. If you no longer have this e-mail, you can look up the name and number.
Launch EagleFiler and choose Purchase from the EagleFiler menu. Then click the Lost Your
Serial Number? button.
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8 Legal Stuff

EagleFiler and this manual are copyright c© 2002–2006 by Michael J. Tsai25. All rights reserved.

Please distribute the unmodified EagleFiler-1.1.dmg file on the Web, LANs, compilation CD-
ROMs, etc. Please do not charge for it (beyond a reasonable cost for media), or distribute the
contents of the image file in isolation. Do not distribute your serial number.

The software is provided “as is,” without warranty of any kind, express or implied, including but not
limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.
In no event shall the authors or copyright holders be liable for any claim, damages or other liability,
whether in an action of contract, tort or otherwise, arising from, out of or in connection with the
software or the use or other dealings in the software.

EagleFiler is a trademark of Michael Tsai. Mac is a registered trademark of Apple Computer. All
other products mentioned are trademarks of their respective owners.

The following open-source components are used in EagleFiler:

Regular expression support is provided by the PCRE26 library package, which is open source
software, written by Philip Hazel, and copyright by the University of Cambridge, England.

Thanks to Allan Odgaard for some code snippets that are used in the Software Update installer.

libffi27: Copyright c© 1996-2003 Red Hat, Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the “Software”), to deal in the Software without restriction, in-
cluding without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EX-
PRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MER-
CHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL CYGNUS SOLUTIONS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

25mailto:mjt@c-command.com
26http://www.pcre.org
27http://sourceware.org/libffi/
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PyObjC28 - Copyright 2002, 2003 - Bill Bumgarner, Ronald Oussoren, Steve Majewski, Lele Gaifax,
et.al.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the “Software”), to deal in the Software without restriction, in-
cluding without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EX-
PRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MER-
CHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFT-
WARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Python29:

1. This LICENSE AGREEMENT is between the Python Software Foundation (“PSF”),
and the Individual or Organization (“Licensee”) accessing and otherwise using this
software (“Python”) in source or binary form and its associated documentation.

2. Subject to the terms and conditions of this License Agreement, PSF hereby grants
Licensee a nonexclusive, royalty-free, world-wide license to reproduce, analyze, test,
perform and/or display publicly, prepare derivative works, distribute, and otherwise
use Python alone or in any derivative version, provided, however, that PSF’s License
Agreement and PSF’s notice of copyright, i.e., “Copyright c© 2001, 2002, 2003, 2004,
2005, 2006 Python Software Foundation; All Rights Reserved” are retained in Python
alone or in any derivative version prepared by Licensee.

3. In the event Licensee prepares a derivative work that is based on or incorporates Python
or any part thereof, and wants to make the derivative work available to others as pro-
vided herein, then Licensee hereby agrees to include in any such work a brief summary
of the changes made to Python.

4. PSF is making Python available to Licensee on an “AS IS” basis. PSF MAKES NO
REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED. BY WAY OF
EXAMPLE, BUT NOT LIMITATION, PSF MAKES NO AND DISCLAIMS ANY
REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS FOR
ANY PARTICULAR PURPOSE OR THAT THE USE OF PYTHON WILL NOT IN-
FRINGE ANY THIRD PARTY RIGHTS.

28http://pyobjc.sourceforge.net/
29http://www.python.org/
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5. PSF SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF PYTHON
FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES OR LOSS
AS A RESULT OF MODIFYING, DISTRIBUTING, OR OTHERWISE USING PYTHON,
OR ANY DERIVATIVE THEREOF, EVEN IF ADVISED OF THE POSSIBILITY
THEREOF.

6. This License Agreement will automatically terminate upon a material breach of its
terms and conditions.

7. Nothing in this License Agreement shall be deemed to create any relationship of agency,
partnership, or joint venture between PSF and Licensee. This License Agreement does
not grant permission to use PSF trademarks or trade name in a trademark sense to
endorse or promote products or services of Licensee, or any third party.

8. By copying, installing or otherwise using Python, Licensee agrees to be bound by the
terms and conditions of this License Agreement.

9 Version History

1.1—December 6, 2006

Importing

• EagleFiler will now let you import any kind of document. If it doesn’t know how
to display the document, it will simply show the file’s icon, which you can click to
open it in another application.

• When importing via drag and drop, you can now drop onto folders or tags in the
source list or into the records list in order to put the imported records into that
folder or assign them that tag.

• Now recognizes many more kinds of text files and text clippings.
• Can now import individual messages from Entourage via drag and drop.
• Added Command-< keyboard shortcut for the Import Text service.
• You can now import by control-clicking on a file in the Finder and choosing Open

With . EagleFiler.
• Added Import Clipboard command to the Dock menu.
• It is now possible to specify tag names and note text when importing via AppleScript.

Capture

• Can now capture IMAP mailboxes and individual selected messages from Apple
Mail.

• Can now capture from Endo30, Firefox31, and WebnoteHappy32.
30http://kula.jp/software/endo/
31http://www.mozilla.com/en-US/firefox/
32http://www.happyapps.com/webnotehappy/
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• If you press the capture key when there is no library open or while in an unsupported
application, EagleFiler will now try to help you open a library or import the data
in another way.

• Capture scripts can now import tags and notes.

Text and Rich Text Files

• It’s now possible to edit text, RTF, and RTFD files directly in the record viewer.
EagleFiler will automatically save any changes that you make and update the files’
checksums.

• Creating new rich text files is much smoother. The keyboard shortcut is now
Command-N instead of Command-Control-N. If the File column is visible, Eagle-
Filer will bypass the sheet, select the new file in the records list, and bring the File
cell into edit mode so that you can set the filename and title. You can then tab into
the record viewer to begin typing the contents of the file.

• You can drag records into the record viewer (or the notes text view) to create links
to them.

Searching

• You can now search by tag. You can also add tag criteria when doing an Anywhere
or Notes search (e.g. tag:apple steve).

• Now remembers the last-used search scope (globally and per-window).
• You can now access the search syntax help page from the toolbar search field menu.

Tags

• Added auto-completion when typing tag names.
• Added tags field to the bottom of the browser window. so that you can edit the tags

of the selected record without having to open another window. You can quickly give
the tags field keyboard focus by pressing Command-Shift-T.

• Tag sources now show all the e-mails with that tag (rather than just the files).
• Tag sources now behave more like iTunes playlists and iPhoto albums. If you delete

a record from a tag source, EagleFiler unassigns the tag, but the record remains in
the library.

• You can now arrange tags into a hierarchy in the source list, to organize them or to
hide the ones you don’t want to see at the moment.

• Added New Tag menu command. If records are selected it changes to New Tag
From Selection and the selected records are assigned the new tag.

Browser Windows

• You can now single-click to edit the Title, From, or File directly, instead of having
to open the Inspector window.

• Added Convert For Editing command, which lets you convert Web archives to RTFD
files that can be edited.

• If you hold down Option when double-clicking a Web archive (or a RTFD file con-
verted from a Web archive), EagleFiler opens the current version of the page rather
than the archive.
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• EagleFiler now shows custom icons for folders. You can set a custom icon using the
Finder’s Get Info window.

• Added Show . Source List and Show . Record Viewer commands for people who
want to use the menu or keyboard intead of double-clicking the divider.

• Added Actual Size and Zoom to Fit commands. The PDF viewer now remembers
its zoom state, so that it won’t keep resetting to Zoom to Fit if you’ve zoomed in.

• Remembers the selected sources between launches.
• Arrow-keying through the records list is faster now.

Libraries

• Added Remember open libraries between launches preference and Startup Items
folder.

• The Drop Pad now has commands for creating a new library, opening a library, and
opening recent libraries.

• The Dock menu now shows recent libraries.

Other Enhancements

• If you ask EagleFiler to import a URL and the URL can’t be saved as a Web archive
(e.g. because it’s an image or PDF), EagleFiler will download the file and import it
as-is, rather than reporting an error about not being able to save a Web archive.

• Now imports MailTags33 projects as tags.
• The Zoom In and Zoom Out commands now work with Web archives, where they

change the font size.
• The Copy URL command is now called Copy Record Link.
• Added Highlight command, which changes the background of the selected text to

yellow.
• Added Outline and Styles. . . to the Format menu.
• Dragging a library file onto the Drop Pad now opens the library rather than com-

plaining that the library can’t be imported.
• Improved the way EagleFiler auto-generates file names when creating a file from

dragged text or a Web page’s title.
• Now skips importing Apple Mail messages that are marked as deleted.
• Capture scripts are now allowed to use the compiled script format, with the .scpt

extension.
• Folders and mailboxes no longer have a title attribute that’s separate from the file

name.
• When creating a new rich text file inside a sub-folder, it’s now revealed there instead

of in the Library source.
• Indexing is now somewhat faster and uses less memory.
• Double-clicking a folder now opens it in EagleFiler instead of in the Finder.
• In the source list, single-clicking now enters edit mode and double-clicking now opens

the source.
33http://www.indev.ca/MailTags.html
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• Improved secondary sorting of records list.
• Increased maximum width of the Kind column.
• Added keyboard shortcuts for Select Source and Hide Others.
• Rich text copied using Copy Record Link now includes the tite of the record, rather

than just the URL.
• Now displays the proper background color for RTF documents.
• Added Open Source URL, Copy Record Link, and Verify to the contextual menu.
• The underscore and hyphen characters are now allowed in tag names.
• You can now drag into the records list of a tag source to assign that tag.
• Shortened toolbar button labels.
• The menu commands for Show Inspector and Show Tags now toggle the visibility

of the windows rather than showing them.
• The Software Update checker now works behind an HTTP proxy.
• The Import Files menu command no longer allows you to import individual files

inside an Apple Mail mailbox, as this is usually an error.
• Moved Open in External Viewer command to the Record menu.
• Added keyboard shortcut for Open Source URL.
• Reordered Record menu.
• Reduced number of threads used on single-core Macs.
• You can now delete tags from the source list.

Bug Fixes

• Periods in the names of folders are now treated as part of the name, rather than as
the beginning of a path extension.

• Worked around OS bug that prevented phrase searching from working. Because of
this, EagleFiler will automatically rebuild the indexes of any opened libraries.

• Fixed bug that could cause a crash when importing large folder hierarchies.
• When importing a folder, EagleFiler will now ignore any invisible Find By Content

index files.
• Fixed bug importing and moving files with very long names.
• Fixed bug in .emlx exporter.
• Fixed bug where EagleFiler couldn’t import a Web page if WebKit crashed while

trying to extract its text.
• Fixed bug with using Capture command in Dock menu.
• Fixed bug where EagleFiler didn’t let you capture if you launched it by opening a

library from the Finder and then switched to another application so that it finished
launching in the background.

• The capture key is now ignored if EagleFiler is frontmost.
• Fixed spelling and resizing of “Title” label in the New Rich Text File sheet.
• Fixed crash that could occur when indexing.
• Fixed bug where an indexing operation could stall indefinitely.
• If a document or message can’t be indexed, EagleFiler is better at continuing on

and indexing the rest of the documents or messages.
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• Better logging of index problems.
• Fixed bug where indexed searching didn’t work in tag sources.
• Fixed bug where undo didn’t work after renaming in source list.
• Fixed bug where the user could use drag and drop to change the page that the Web

view was displaying to one other than that of the selected Web archive.
• Better display of messages with no text parts.
• Fixed bug where the Recent smart folders didn’t show records that were inside

folders.
• Fixed bug where Web archives couldn’t be displayed, depending on if you had certain

preferences set in Safari.
• Fixed bug where the selection in the notes text view would be needlessly reset when

the library changed.
• Fixed bug that could lead to error when undoing too far in the notes text view.
• No longer allows you to give a file an empty name (before the extension), as this

confuses Cocoa.
• Fixed bug where the Show Inspector command opened the inspector but didn’t give

it keyboard focus.
• Worked around OS bug that could cause crash when using NetNewsWire Lite.
• Fixed a few bugs that made it impossible to launch EagleFiler from a path containing

non-ASCII characters.
• Fixed small memory leak when processing errors.
• Fixed bug where you couldn’t create a new folder with / in the name.
• Fixed bug where showed : instead of / when displaying file names.
• The file system encoding is no longer hard-coded to UTF-8.
• Improved thread-safety of record properties.
• When launching, no longer prints “CMSCreateDataProviderOrGetInfo : Invalid

colorspace type” message to console.
• Fixed bug where changes to a file’s name or title weren’t always propagated to the

index.
• Fixed bug where source URLs weren’t being cached properly.
• Fixed bug opening aliases of libraries.
• Fixed bug where you couldn’t create or open a library if its path contained non-

ASCII characters.
• Worked around bug in SOHO Notes (and other applications) that prevented drag-

and-drop importing of promised files from working.
• Fixed bug importing notes from MailTags34.
• Fixed bug where the drag image for a selected source used white text.
• Fixed bug where displaying an HTML e-mail message would take too long to time-

out.
• Fixed bug in reporting HTML rendering errors.

34http://www.indev.ca/MailTags.html
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• Fixed internal error when closing a library right after opening it.
• Improved error recovery when an untrusted server certificate is encountered while

creating a Web archive.

1.0.2—October 14, 2006

• Fixed bug capturing from Apple Mail.

1.0.1—October 14, 2006

• Fixed problem where EagleFiler would sometimes crash at launch if an input manager
or haxie was installed.

• Worked around OS bug that caused jitter in the software update progress bar.

• The software update installer no longer says it failed if it succeeded.

1.0—October 13, 2006

• First public release.
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